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INTRODUCTION 

 
The 2021-2022 National Certificate of Education (NCE) Assessment for Information and 

Communications Technology (ICT) was based on the Expected Learning Outcomes 

stated in the National Curriculum Framework (NCF) Grade 7, 8 & 9 and detailed in the 

ICT-Teaching and Learning Syllabus (2017) Grades 7, 8 & 9.  

  

Candidates are assessed according to three Assessment Objectives (AOs), namely: 

• AO1 - Knowledge & Comprehension 

• AO2 - Application 

• AO3 - Analysis 

 

Table 1 gives a breakdown of the weighting allocated to each of the assessment 

objectives. 

 

Learning Area Weighting (%) 

Knowledge and Comprehension 50% 

Application  30% 

Analysis  20% 

 

Table 1: Weighting of Assessment Objectives  

 

The aims of this report are to: 

• describe the candidates' overall performance in the paper.  

• give an insight about the general difficulties faced by candidates. 

• indicate which questions were well answered by candidates. 

• show expected answers for certain questions. 

 

The NCE Examiners’ report for ICT offers valuable feedback on the performance of 

candidates and is meant to guide future candidates when preparing for the assessment.  

This report should be read in conjunction with the 2022 ICT question paper for the 

assessment, available on the MES website. 
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PAPER OVERVIEW 

 

The paper consists of 11 questions organised into two sections namely, Section A and 

Section B.  The overall breakdown of the paper is given in Table 2. 

 

 Questions Number of marks 

Section A 1 to 5 50 

Section B 6 to 11 50 

 
Table 2 - Breakdown of the ICT paper 

 

The paper included different types of questions such as multiple-choice questions 

(MCQs), fill in the blanks, True/False, matching, labelling, ticking (✓), short- answer 

questions, sequencing and computational questions. An outline is provided in Table 3 

along with the number of marks allocated for each question. 

 

Table 3 -Types of questions and marks allocated 

Section Question Types of questions Marks 

allocated 

S
e
c
ti

o
n

 A
 (

5
0
 m

a
rk

s
) 

1 Multiple choice questions (MCQs). 15 

2 Fill in the blank questions.  10 

3 True/False questions, where the candidates were 

required to use a (✓) to indicate their answers. 

10 

4 The first part of the question was based on matching and 

the second part was labelling. 

10 

5 Part (a) was a multi-select question and for part (b) 

candidates were required to tick (✓) only one option.  

5 

S
e
c
ti

o
n

 B
 (

5
0
 m

a
rk

s
) 

6 Short answer questions based on a table of 

specifications of two laptop computers. 

7 

7 Multiple choice question (single-select), sequencing and 

fill in the blanks. 

7 

8 Tick (✓) and short answer questions.  9 

9 Short answer questions and tick (✓) based on a 

spreadsheet.  

10 

10 Matching, short answer questions and labelling. 7 

11 Part (a) was related to labelling and the part (b) was a 

computational type question. 

10 
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Key messages 

 

• Section A of the paper was accessible to candidates in general. Many of them scored 

good marks which improved their overall score in the paper. 

• Candidates must read each question carefully and follow all instructions given when 

answering the questions. 

• It is important for candidates to be able to apply their knowledge of the different topics 

to fulfill the requirements of certain questions. 

• ICT being a technical subject, it is recommended that candidates use appropriate 

technical terms related to specific concepts when answering. 

• Candidates should clearly indicate their selected option when answering MCQs and 

to insert the (✓) within the allocated space to avoid any confusion to examiners. 

• Any new answers should be clearly written after crossing out any incorrect ones or 

related rough work. 

 

 

General Comments 

 

• Candidates were required to answer all the questions.   

• A few candidates did not attempt some multiple choice and TRUE/FALSE questions. 

• The questions related to databases were quite challenging for many candidates.  

• Dry running of flowchart continues to be problematic for many candidates.  They were 

unable to differentiate between variables and the values to be inserted in the trace 

table. 

• Some candidates had difficulty to differentiate between the flowchart symbols and thus 

incorrectly wrote the statements. 

• Question 8(c) was challenging for candidates to answer.  They could not correctly 

identify two different purposes of the VPN. 

• For Question 8(d), candidates could not clearly distinguish between the purposes of a 

NIC and a MODEM.   

• Question 4(b) was the most popular among candidates with most of them scoring at 

least 1 mark. 
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Comments on specific questions 

 
SECTION A 

 

Question 1 (15 marks – 1 mark per correct answer) 

This question consists of 15 multiple choice questions (MCQs). Candidates were required 

to correctly identify one answer for each item. 

Part 
Correct 

Answer 
Remarks 

i.  B 

Most of the candidates correctly identified B as the correct answer.              

The icons provided were helpful.  

 

 

ii.  A 
This item was well answered by many candidates. However, option C was 

a major distractor. 

iii.  D 
Many candidates gave the correct answer D. Nonetheless, option C was a 

popular distractor. 

iv.  A 

This was the least well-answered MCQ item.  

 

 

 

 

 

 

 

 

 

 

Many candidates were not able to identify the correct print layout which was 

option A (Notes pages). Candidates did not pay attention to the speaker’s 

notes given below the slide. Option D - ‘Full page slides’ was a strong 

distractor as nearly half of the candidate population opted for it. 
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v.  C 

This was the most well answered MCQ item. Nearly 96 % of the candidate 

population correctly related the name in cell A5 to its corresponding value in 

cell B5. 

vi.  B 
Many candidates were able to identify the correct network topology ‘Bus’.  A 

few candidates wrongly opted for ‘Mesh’ topology. 

vii.  B 

Candidates confused between the popular distractor ‘Wiki’ and 

the key ‘Blog’. It appears that many candidates were not familiar 

with these terms. 

viii.  D 

It was noted that many candidates incorrectly associated ‘allocation of 

storage space to programs and data’ to ‘File Management’ instead of 

‘Memory Management’.  

ix.  B This item was generally well answered. 

x.  A Many candidates correctly attempted this item. 

xi.  B 
This item was fairly well answered.  Some candidates incorrectly opted for 

A - ‘General speech balloon’ or C – ‘Thought balloon’. 

xii.  B 
A few candidates wrongly opted for ‘Selection’ or ‘Sequence’ instead of the 

key ‘Repetition’. 

xiii.  B 
This item was fairly well answered. However, option D, ‘Wifi’ was a major 

distractor. 

xiv.  C 
More than 75 % of the candidate population correctly identified ‘Internet 

Service Provider’ for ISP. 

xv.  D 

This item was not well answered by many candidates.  

 

 

 

 

 

 

 

 

 

Candidates should understand that the values in a key field need to be 

unique for each record in the database.  
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NOTE: 

 

In cases where candidates wrongly encircled an option in the multiple-choice questions, 

they are advised to: 

either 

• cross out the option which was wrongly selected and encircled. 

• encircle the letter corresponding to the option they now think is correct and indicate 

this clearly using an arrow and the word ‘Answer’, as illustrated below: 

 

 

or 

• cross out the option which was wrongly selected and encircled. 

• encircle the letter corresponding to the option they now think is correct and indicate 

this clearly using an arrow only as illustrated below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Answer 

 

Answer 
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Question 2 - Fill in the blanks questions (10 marks – 1 mark per correct answer) 

This question was successfully attempted by many candidates. Around 43 % and 53 % of 

candidate population scored full marks for parts A and B respectively and nearly 64 % of 

the cohort was able to score at least 3 out of 5 marks. 

However, some confusions were noted: 

• For part (A), candidates incorrectly used the terms ‘network’ and ‘server’ for item (iv). 

• For part (B), items (iii), (iv) and (v) were problematic as some candidates seemed not 

to be familiar with the terms ‘computer ethics’, ‘plagiarism’ and ‘handouts’.  

(A) 

No 
Correct 
Answer 

Remarks 

i.  RSI 
Mostly well answered, candidates correctly identified RSI as ‘Bad 

posture’. 

ii.  Ergonomic 

Most candidates correctly related ‘back pain’ to the use of 

‘ergonomic’ chair as a means of prevention. This was the most well-

answered item for part A. 

iii.  Backup Mostly well answered.  

iv.  Server 
Some candidates confused between the correct answer ‘server’ and 

‘network’. This was the least well-answered item for part A. 

v.  Binary 
Mostly well answered with candidates successfully relating ‘0s and 

1s’ to ‘binary’ data. 

 

(B) 

No Correct  

Answer 
Remarks 

i.  Web browser 

This was the most well answered item in part B, with candidates 

correctly identifying ‘web browser’ as the program required to view 

web pages. 

ii.  Terminal 
This item was fairly well answered.  A few candidates wrongly 

opted for ‘Password’. 

iii.  Computer ethics A few candidates were confused between the terms ‘computer 

ethics’ and ‘plagiarism’. 
iv.  Plagiarism 

v.  Handouts 
This item was fairly well answered. Incorrect answers that were 

given by candidates included ‘plagiarism’.  
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Question 3-Tick (✓) the correct boxes (10 marks – 1 mark per correct answer) 

 

No 
Correct 
Answer 

Remarks 

(b) True 

More than three quarter of the candidate population correctly answered 

item (b). Candidates showed understanding that ‘paper jam’ can be a 

reason for the printer not working properly. 

(c) True 

Item (c) was the most well answered part of question 3.  Candidates 

were able to relate the term ‘hacking’ to ‘unauthorised’ access. 

(d) False Many candidates wrongly answered item (d). Candidates were not 

familiar with the features available in the ‘Home Tab’. 

 

(e) True Item (e) was fairly well answered. However, some candidates were not 

familiar with the features available in the ‘Insert Tab’. 

(f) False Item (f) was well answered by most candidates. Candidates correctly 

understood that a ring topology does not have any central component. 

 

(g) False More than 75% of the candidate population answered item (g) well as 

they correctly identified that a computer virus is not a hardware. 

(h) True For item (h), many candidates demonstrated good knowledge of the 

availability of free plagiarism checkers on the internet. 

(i) True For item (i), candidates correctly understood the use of radio waves by 

WiFi to provide wireless internet. 

(j) True Item (j) was the second most well answered part of question 3. Most 

candidates correctly understood that a flowchart is read from top to 

bottom. 
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(k) False Item (k) was the least well answered part of question 3 as more than 

half of the candidate population gave the wrong answer. Many students 

had difficulty in understanding the concept of ‘query’ and wrongly 

selected ‘True’ as the answer. 

 

 

 

Question 4 - (10 marks: Part (a) – 6 marks and Part (b) – 4 marks) 

4(a) Match Column A to Column B 

The majority of the candidates used the grid to record their answers; however, some 

candidates used connecting lines to show their answers. 

 

Item Remarks 
Correct 

Answer 

(ii) Most candidates correctly identified option 4 from Column B.   4 

(iii) 
Most candidates successfully identified ‘error handling’ as one of the 

functions of an operating system. 
6 

(iv) 
Nearly half of the candidate population could not correctly identify 

option 8 as the correct answer. 
8 

(v) Many candidates correctly identified option 7. 7 

(vi) 
This item was fairly well answered. Some candidates confused PAN 

with LAN and therefore, gave the incorrect answer. 
5 

(vii) 

Most candidates could identify the correct match-option 1. This item 

on ‘Game addiction’ was the most well answered part of question 4 

(a). 

1 
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4(b) – Label pictures 

 

Correct Answers 

Above 95% of the candidate population correctly answered this part of the question- 

gaining full marks. Most candidates were able to score at least 1 out of the 4 marks. In 

exceptional cases, the microphone was mistaken for a mouse and the router was mistaken 

for a printer.  

 

 

 

 

 

 

 

 

 

 

 

Microphone Router 

Printer Compact Disc 
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Question 5 [5 marks: Part (a) – 3 marks and Part (b) – 2 marks] 

5 (a) Tick (✓) the three (3) possible solutions to make the speakers work. 

The majority of candidates correctly ticked 1, 3 and 5. 

However, some candidates did not follow the instructions in the question which required 
only three options to be selected.  
 
 

5 (b) Tick (✓) the correct key combination which needs to be pressed to retrieve a  

         file which has been deleted accidentally. 
 
Many candidates correctly identified ‘Ctrl + Z’ as the correct answer. Some candidates 
did not score any marks since they described the purpose of the given shortcuts.  
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

✓ 

✓ 

✓ 
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SECTION B 

Question 6 (7 marks) 

(a) Most candidates correctly identified Laptop B as having a higher processor speed.  

 

(b) (i)  

 

 

 

 

 

Many candidates confused memory size with hard disk capacity and, therefore, 

incorrectly gave ‘500 GB’ instead of ‘4 GB’. 

 

 

(ii)  

 

 

 

 

Many candidates were able to give one advantage of Laptop B over Laptop A. 

However, in some cases, candidates did not score the mark as the advantage 

provided was not related to memory size. 

 

(c)  

 

 

 

 

 

 

Nearly half of the candidate population scored full marks. Many candidates were 

able to score 1 mark for correctly identifying Laptop B. However, some candidates 

did not earn the second mark because the reason given was not valid. Candidates 

were expected to either relate to the specifications given in the question when  

giving their answers or to indicate that laptop B can be selected for performing an 

easy backup.  Most common answers were related to the speed of laptop B.  Marks 

were also allocated when reference were made to other valid features.  

 

(d) This part was well answered by most candidates. A few candidates did not 

understand the question and wrongly stated the specification for the webcam of 

Laptop B. 
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Question 7 (7 marks) 

 

(a)  

 

 

 

 

 

 

 

 

 

 

 

Generally, this question was well answered by most candidates.  The most common 

incorrect option chosen was the ‘Layout tab’. 

 

 

(b) Many candidates were able to score full marks in this part question. Those who lost 

marks were unable to determine the correct order of the mail-merge steps. The 

expected answer was: 

 

Step Order 

Insert fields to merge the two documents 3 

Create a mailing list 1 / 2 

Create a template 2 /1 

 

 

 

(c) This part of the question was well answered by more than three quarter of the 

candidate population who scored full marks. However, a few candidates missed one 

or two fields while writing their answers. 
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Question 8 (9 marks) 

 

(a)  
 
 
 
 
 
 
 
 
 

 

Most candidates were able to correctly tick ‘intranet’ for the first statement and 

‘extranet’ for the second statement. 

 

(b) Many candidates correctly gave the full form for the acronym of VPN as ‘Virtual Private 

Network’.  Some incorrect answers included Virtual Personal Network, Virtual Process 

Network or Virtual Public Network. 

 
(c) This part question was quite challenging for many candidates who could not 

understand the purpose of a VPN. Marks were allocated to answers related to creating 

a secure connection or protection of online privacy or remote users connecting to a 

server. Other valid answers were considered and marks were allocated accordingly. 

 

(d) Candidates had difficulty to explain the purpose of (i) NIC and (ii) MODEM and, 

therefore, could not score full marks.  

 

 
Candidates could not correctly understand that a NIC allows a computer to be 

connected to a network. Many candidates confused the terms MODEM and Router. In 

some cases, candidates gave general answers that could not be awarded marks. More 

than 65% of the candidate population could not score any mark for part (d)(i) and (d)(ii). 
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Question 9 (10 marks) 

 

(a)  

 

 

 

 

 

 

 

 

 

Some candidates did not identify the correct cell addresses. Common incorrect 

answers were ‘Keerthi’ for part (i) and ‘Sanchita’ for part (ii).  A handful of candidates 

gave either the column letter or row number and, thus, no marks could be allocated. 

 

(b)  

 

 

 

 

 

 

 

 

 

Many candidates selected the correct formula. 

 

(c)  

 

 

 

 

 

 

Less than 25% of the candidate population scored full marks for this part question. 

Common mistakes were incorrect range and incorrect function. Some candidates 

wrongly reproduced the formula for calculating BMI. This part was not attempted by a 

few candidates. 

 

(d) Nearly half of the candidate population did not score any mark for this part question.  

In some cases, the condition was correctly written but the output was incorrect. In other 

cases, the condition was left blank or was incorrect, but the output was correct. 
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(e)  

 

Part (e) was fairly well answered. Some candidates gave the value 22.86 instead of 

the cell address D3. 

  

 

(f)  

 

 

 

 

 

 

 

 

Part (f) was well answered by many candidates. However, a few candidates gave the 

3 cell addresses instead of the value 3 and thus no mark was allocated. It is important 

for candidates to understand that the COUNTIF() function returns an integer value and 

not cell addresses. 

 

 

 

 

 

 

 

 

 

 

 

 



Page 19 of 22 
 

Question 10 (7 marks) 

(a) Most candidates correctly matched the terms in Column 1 with their corresponding 

descriptions in Column 2. 

 

(b) (i)  Around 80% of the candidate population were able to identify that there were 5 

records.  

 

(ii)  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This part proved to be challenging for most candidates as less than 20 % of the 

candidate population were able to score at least 1 out of 2 marks. Some candidates 

listed only one output instead of 2. Other candidates did not give the output in the 

correct order. A handful of candidates listed additional fields with the output. 

 

 

(iii) This part was also problematic for many candidates as nearly 50 % of the candidate 

population could not score any mark. Some candidates did not attempt this part. Many 

candidates copied the sort order and “<30” from part (ii) into part (iii) even though these 

were not required.  

 

The QBE grid below shows an expected answer. However, other valid answers were 

also considered.  

Field COURSE_NAME CAMPUS 

Table COURSES COURSES 

Sort   

Show 
  

Criteria    = “REDUIT” 

Or   
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Question 11 (10 marks) 

(a) This part was relatively well answered by most candidates and around 50 % of the 

candidate population were able to score full marks. However, a number of candidates 

did not follow the instructions and wrote the statements instead of inserting the 

appropriate number in the symbols. Most candidates scored at least 1 mark in this 

part.   

 

A common mistake was the inability of some candidates to differentiate between the 

process symbol and the decision one thereby assigning the incorrect statement 

number.  Some candidates did not pay attention to the fact that two examples were 

given to them and they wrote the corresponding statement in the symbols by crossing 

out the statement numbers.  It was also noted that some candidates referred to part 

(b) when answering part (a). As such incorrect statements such as ‘Input X, Y’ or 

‘Output Z’ were found.  The figure below shows the expected answer for this part 

question. 

 

5 

1 /4 

4 / 1 

 

2 

8 

 

6 

 

3 

7 
Yes 

No 



Page 21 of 22 
 

(b) Around 15% of the candidate population was able to score full marks in this part 

question. However, nearly 75 % of the candidate population was not able to score any 

mark. Many candidates did not attempt it.  

Many candidates wrote the variable names X and Y as output instead of the respective 

values. The same was noted for the ‘Process’ column.  Some candidates did not 

complete the ‘Process’ column. 

The table below shows the expected answer. 

 

 

 

 

 

 

 

 

Suggestions /Recommendations 

 

1. Students should be encouraged to: 

 

• read the questions carefully. 

• identify the key elements of a question. 

• focus on the key words of a question which are often set in bold. 

 

2. Write an answer in relation to the marks allocated for the question. 

 

3. Candidates should properly describe the term or concept whenever required. They 

should focus on key parts of the definition or explanation.   

 

4. Many candidates experienced difficulties when answering questions which 

assessed their knowledge of application software.  It is important for candidates to 

identify the features of the different application programs and the tabs to be used 

to access them. 

 

5. Students need to practise more questions on spreadsheets that focus on:  

• Writing different formulas 

• Use of IF() and COUNTIF() 

• Different options available for conditional formatting 

 

6. For databases, students are encouraged to: 

• analyse and understand a given QBE grid. 

• retrieve the required records and fields based on a given QBE grid. 

INPUT PROCESS OUTPUT 

X Y Z  

10 2 14 10, 2 

4 2 8 8 

1 3 10 10 

8 4 24 8,4 
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• represent a given scenario by correctly completing a given QBE grid.  

 

7. For flowcharts, students should be able to: 

• properly identify and draw symbols required at a given stage. 

• relate key words in a statement to a flowchart symbol, for example, any 

statement that starts with “Is” indicates the use of a decision symbol. 

• identify the sequence of steps in the given scenario in the question so that 

the flowchart is correctly drawn or labelled. 

• dry run a flowchart by substituting values of variables and identify the 

correct path to follow with the aim of finding valid outputs or processing. 

• correctly fill in the dry run table.  

 


